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Let the Better Browsing Bureau help vou become a better browser...

THE BETTER BROWSING BUREAU

Like the proverbial frog in a gradually-warming pan of waler, most of us find ourselves spending more
and more time on the intermet; and most of thal ever-increasing online activity is funnclled through a
single piece of software — a web browser, While other important applications such as word processing
applications and spreadsheels were designed from seratch with a specific purpose in mind, web
browsers have developed inerementally along with the web itsell; and being free, they seldom undergo
the same level of scrutiny and review that Microsoft Office or Adobe Acrobat attract at budget time.

Now (hat the browser hattleground — once a Microsoft waltkover — has been reinvigorated by the
arrival of Google Chrome and the increasing popularity of Mozilla Firelox, Fortuity Labs has decided
it’s time to take a fresh look at web browsing, Some of their best and brightest have been allocaled 1o
a new Better Browsing Bureau, with a simple assigmment: help clients obtain the most benefit and the
least aggravation [rom their (ime online. Here are some exlracts from their working brief,

CHOOSING A BROWSER

A web browser has three bagie functions: it looks up a URL,; downloads a copy of what it finds there
to your hard drive; and displays it on your screen. Interactive sites add a fourth funclion: sending back
to the site the information that you enter. The earliest web browsers did very little other than interpret
HTML code, and this is still a major part of their job - in fact all browsers are still cquipped to let you
look “behind the scenes™ at the raw code they are handling (check the bottom of the View menu for a
*View Code” or “View Source” oplion). In the past different browsers interpreted the code in dillerent
ways, resulting in the WYSIWYWPGIYL syndrome among web designers — “What You Sec Is What
You Will Probably Get Il You're Lucky”. But these differences have largely been resolved, and
designers can now be reasonably confident that as long as they don’t get too fancy, their pages should
look the same in every browser.

So which browser should you choose? Microsoft has an advaniage hecause their Tnternet Explorer
comes preinstalled on most Windows sysiems. Bul what about the new kids on the block — Mozilla
Fircfox, Google Chrome, Opera and the Macinlosh Salari? Each set of users will passionately defend
the browser of their choice, bul anyone trying to make an objective judgment necds to loek at three
main [actors:
= Speed — how [ast does it start up and how quickly doces it retrieve pages?

- Security — how vulnerable is it to altack and misdirection?
«  Extensibility — how much can it be enhanced and customised?

The speed factor is a selling point for Opera, the browser developed in Norway, which claims to be
both laster and saler than it rivals, The latest Opera also includes a new feature — a “trash can” which
stores he addresses of pages you've closed in case you change your mind and want (0 open (them
again, Firefox also makes a point of its speed, and there are hundreds of exlensions written for Firclox
by the open-source community that provide extra features like password eneryption, phishing
avoidance and — huzzah! -- blocking advertisements. Google Chrome is a newcomer but catching up
quickly with all those dollars bchind it.

Faced with these challenges Microsoll has been forced to lilt its game, and the new Internet
Explorer 8 has many improvemen(s on the older versions; bul at a minimum of 50 Mb (going way up
if other components are added) it's six times the size of Opera and seven times the size ol Firefox; and
much easier, as 4 resull, for would-be hackers to find points of vulperability in. Another black mark lor
Microsoft: it remains obstirately locked (o the Windows plalform, while the other major browsers now
offer support for Linux and Macintosh as well, Even the Salarl Mac browser from Apple comes with
a Windows version, And scaled-down versions of these browsers are [inding their way on o PDAs and
mobile phones loo.
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CUSTOMISING YOUR BROWSER

Choosing a browser is only half the story, The next step is 1o modifly it to suit your requirements.
Some users — especially those who are visually impaired — may need to make extensive changes;
others may be able to get away with a few cosmelic Lweaks. Whalever your needs, here are some
oplions to consider.

Toolbars and panels

Usc the View menu to decide which loolbars to make visible, and the Cuslomise option to add and
reposilion the toolbar butltons that you need and remove those you dor’t. If you have a wide screen
vou might want (o turn on the Sidebar (or Pancl) eption under View (o display a panel at the lell. By
delault this pane! can show your bookmarks or your browsing hislory, but some add-ons like Delictous
also provide sidebar display options as well,

Bookmarks/links

If your Links toolbar (“Bookmarks Toolbar” in Firelox) is open you can drag webpage addresses here
from the address {ield. All browsers now come with 2 “Manage (or Organize) Bookmarks™ menu item
which allows you to move bookmarks into folders and subfolders by category. One advantage of
grouping bookmarks inlo folders is that you can then open all the bookinarks in a folder with onc
click; this is ideal for your daily review ol the main news sites — or the comic strips.

Fonts and colours

ook under EdiVPrelerences or Tools/Oplions Lo find the font and colour customisation scitings for
your particular browser. Users with ageing eyes may just want o turn the minimum font size up 2
little; those who are colourblind or visually impaired may nced to make more drastic changes. Users
who need complete contro! over the display of webpuages can usc the same method that web designers
do, and atlach cascading style sheet (CSS) files that specify in detail how each comporent of every
page should appear. Meanwhile, for individual pages, you should be able to adjust the font size by
holding down the Control key and rolling the mouse wheel.

Cookies

Cookies are small text files that are downloaded [rom the sites you visit and stored in a specific
directory on your hard disk. The next lirne you visit the site, il can re-open its own cookic and find out
when you were there lasl, along with other information that you may have entered like your name and
password. There was some agitation over cookies in the carly days of the web, but most people seem
to have become resigned to them. I they become a nuisance you can turn them ofl’ via the Privacy
settings under Tools/Options or Edit/Preferences. Cookies and other ongoing information relained by
the browser can also be purged on a one-off basis via the Clear {or Delcte) Private Data command,
usually found under the Tools menu.

Security settings

More worrying than cookies is the risk of losing control of your computer — or your bank account —
viz onc of the deceptive “phishing” sites that abound on the web. All browsers now have sccurity
selling options which can warmn you when you open a page considered dangerous. Thesc settings also
allow you to manage the passwords that your browser can store for cBay, PayPal and other
passworded sites. Firefox and Opera, [or instance, can be set to ask the user for a “masler password”
before they cough up the actual password [or & protected site.

Add-ons/plug-ins

All the major browsers support some kind of add-on (aka “plug-in} system for optional extras, but
Firefox has the widest range by far. A look at hitpr//www.addons.mozilla.org shows well over 10,000
of these, ranging from near-cssentials like advertisement blockers (o [rivolous loys like animaied
jugglers. There are also tools designed to work with popular online sites like ¢Bay, Facebook, Flickr
and YouTube. A few minules spent here can save you hours of irritation wrestling with unwanted
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conlent and recalcitrant webpages later on. Similar but less comprehensive collections can be {ound
online for Internct Explorer (hitp:/fwww.isaddons.com), Opera (hitp:/www.opera.com/docs/plugins)
and Google Chrome {httpr//www.mychromeaddons.com). Add-ons will occasionally conflict with
another, or cause problems on cerlain pages, and il this happens they can be temporarily disabled or
permancntly uninstalled via the Tools menu,

Themes/Skins

Finally, with the hard work over, you can kick back and prettify your browser with Themes - aka
“Skins” in Opera and Chrome — which change its appearance but not (you hope) its {unctionality. For
Firefox these can be found under the Add-Ons menu jtem, while Opera has a spectal “Appearance”
option under Tools. Internel Explorer is more resistant lo customisation, but users who arc particularly
keen can find a fow websites that explain how (o tweak its appearance.

SYNCHRONISING AND BACKING UP

That's one browser aken care of, but what i’ you're browsing al home when you discaver a useful
site, and you wanl io have it available when you go inte work the next day? Or you're reinstalling
your browser after a system crash, and you want to reinslate the same bookmarks you had before?
Luckily there are bookmark and password synchronisation add-ons available for all major browsers,

For example, the Xmarks add-on for Firefox, Internet BExplorer and Salari  (hitp//
www.xmarks.com) allows you Lo set up a {ree passworded account on the Xmarks site to store your
bookmarks in. Any changes you make to your bookmarks can be uploaded to the Xmarks site, either
automatically or on request. Move on (o another computer, fire up your browser, and your modified
bookmarks can be downloaded from Xmarks and installed to that PC. Users are given the choice of
replacing all the current hookmarks or just adding 1o thens; and any bookmark changes made on this
computer can be uploaded in the same way, so that all your bookmarks remain current wherever you
are working from.

NXmarks ollers the same service for passwords — suitably encrypled and protected, of course.
Similar functions are available from Zinkmo (hipp:/www.zinkmo.com); and not to be outdone,
Gaogle Chrome has built the feature into their latest browser version.

Users who want more security can backup their complete Firefox profile, including bookmarks,
add-ons, themes and seltings, with the FEBE extension, though this requires a little more work 1o
restore aflerwards, FEBE also works with the free online storage site httpo//www.box.net o slore your
hackups online, safely away [rom fire, flood and thefi. Other online backup systems like SugarSync
and DropBox can be sct up to provide the same Tunctionality.

URL SHORTENING

Betler browsing also means saving your clients’ and customers’ lyping fingers. The aggravation that

results from Lyping a long URL like;
http://www.webindexing.biz/index.php/clients-a-afliliations-mainmenu-44/59-indexing-clicnts

(and gelling it wrong and Lyping it again, and again) can be easily avoided, Considerate authors and

wel designers will make life happier for everybady by using short, punchy, URL aliases for those

unforgivably long addresses — and there are plenty of sites which offer just that.

Longest-established and besl-known is TinyURL (hitp:/Aswww. (inyurl.com), which warks in three
ways. Method onc: type a long URL into the address field on its homepage, and it will gencraie a
short, permancnt, unique alias for you. A user typing this address inlo their browser will be redirecled
to the original page via the TinyURL site. For example, the address above was transmuted into:

hupdfwww.linyurl.com/liyupi.

II'someone has already created a TinyURL for that page, you'll be referred 10 that, rather than a new
one being generated.
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Method two is to concocl your own more memorable TinyURL address. For instance, 1 converted
the teacher website for Cambridge Sccondary Education at:

hitp://www.cambridge.cdu.au/education/icacher/home.php?s=secondary&n=Home

into:
hitp//wwwi.tinyurl.com/cbZndary.

Custom addresses need 1o be unique, of course; you're unlikely to be able (o use a common word or
name because someone will have almost certainly beaten you to it

Finally, TinyURL capability can be added in to your web browser as an extension or plug-in in
the form of a toolbar, an on-screen button and/or a menu option,

TinyURL is funded by advertising and donations, and its popularity has inspired many imilators,
including a slowish and rather neglected knock-off site at http://www.tinyurl.com.au. More credible
alicrnatives can be found via 2 Google scarch or from the long list at hitp://www.tinyurl.com/yp&cha,
Some of these also offer additional leatures like counting clicks and recording slatistics about your
visitors. Dwar[URL and DecentURL are among the user-fricndliest of these.

Learn to love your browser. I you have to spend time online, you should be doing your best (o
make it as pleasant and sale as possible. Why be a {rog in a pot?

Jon Jermey
Jortuityresearch@ gmail.com
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